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Welcome to the latest edition of my monthly Final Cut Studio newsletter for July/August, 2010.

The goal of this newsletter is to provide information helpful to the interested user
of Final Cut Pro. This newsletter publishes each month, past issues are available
in my store. All software references are to Final Cut Studio (3) unless otherwise
noted.

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll
find daily tips, the latest industry news, and over 500 articles and tutorials to help
you get the most out of Final Cut Studio!

If you haven't done so already, each issue of this newsletter is FREE -- subscribe here. Then,
follow us online:

Larry on Facebook
Larry on Twitter
Latest Industry News from the Digital Production Buzz
Digital Production Buzz Weekly Podcast
Larry Jordan's Blog
Visual Story-telling with 2 Reel Guys
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Batch Exporting Stills

WRAP-UP

WELCOME

Well, I ALMOST got this written in July. Welcome to the summer
doldrums! Time for something interesting to take your mind off the
heat... or, ah, cold depending upon where you are relative to the
equator.

Some of you may have noticed that this is the July issue of the
newsletter -- and, ah, it's August already. Well, my only defense is that
my projects far exceeded the amount of time I had to do them. My
intentions, however, were good; late, but good.

We have lots of interesting stuff to talk about this month. Thoughts on 3D and tapeless video,
a killer new effect from Boris FX, product reviews, and tons and tons of other great goodies!

Also, please visit our new forum -- www.larryjordan.biz/forum. This is a great place to get your
questions answered. Sometimes, I can't visit it as often as I would like, but I'm working hard to
stop by every day to check in.

http://www.larryjordan.biz/forum


It is good to be back with you again. I truly enjoy your comments and feedback on each issue.

So, let's get started.

[ Go to Top. ]

THOUGHTS ON WORKING WITH TAPELESS MEDIA

One of the fun things about researching my weekly webinars is all the new technology I get to
learn and reflect upon.

I was introduced to tapeless media when I was doing a project last year using both P2 and
XDCAM EX formats, media that is shot on cards. Without a doubt the most important point to
keep in mind is that you MUST copy the entire contents of the card to its own folder on your
hard disk. Don't just copy a few files. Copy everything.

Second, put the contents of each card in its own folder. And how you name that folder is
important. (More on that in a minute.)

As part of my recent research for the Tapeless and DSLR Media webinar, I sent a note to a
variety of editors asking for their thoughts on working with tapeless media. Specifically, I
wanted to learn what problems they were running into.

I was fascinated by the results. Take a look.

Stephen Kanter

I've just finished 2 DSLR jobs, and the big issues are:

1. Ignorance of the actual shooting spec. Is it 29.97 or true 30? Is it progressive,
progressive segmented frame or interlaced? Not one of the people I have worked
with knew the answers.

2. Workflow path for ingest. On both jobs, users just used the raw files. One
literally dragged them into a project and cut in H.264, discovering only at the end
that they couldn't get the movie exported properly. Another used Compressor to
transcode to ProRes. However it is possible this was done wrongly, as FCP and
Compressor assumed 29.97 interlaced, when I suspect the true frame rate was
30. Why, oh why, did they not use Log and Transfer with new Cannon plug-in?
Again, if you know the answer to 1. above, feel free to use other methods. But no
one knows 1.

3. Cards must be copied and backed up AS IS with folder structures intact. Fee
photographers seem to understand this. Plus, tracking original filename if they
choose to change clip name.

Shane Ross

#1 - Importing from the cards, then erasing the cards. not backing up the cards
at all...only keeping the imported media. That means that they have no backup.
Or, if they backup THAT footage, then it is tied to that NLE...or makes it difficult
to get to another. PLUS, the imported footage might be larger than the originals,
therefore the backup takes up more space. H.264 to ProRes, or AVCHD to
ProRes...the originals take up less space.

#2 - Backing up only part of the cards. Like only the VIDEO and AUDIO folders
of P2, or only the H.264 files of the Canon DSLR cards. Because FCP needs the
FULL file structure in order to import this footage via Log and Transfer. And the
advantage of using Log and Transfer with Canon DSLR footage is that it adds
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TIME OF DAY code from the camera, instead of having each and every clip have
a start time of 00:00:00:00 like MPEG StreamClip or Compressor does. And it
assigns the clips the REEL number of the backup folder you backed up the
footage into.

I'm sure there are more, but those are the biggies.

Robbie Coblentz -- MidSouth Duplication

Not having an adequate backup strategy thought out to prevent accidental
erasure or non-copying. We build in redundancy at almost every point here,
including long term archive to LTO.

The sometimes fragile nature of all solid state and hard drive media can't be
underscored enough. Hard drives will fail. SD cards will go belly up. This stuff is
still a bit bleeding edge.

You also need to have a standard way of labeling assets to make reconstructing
in the future easier. We mark all our footage data folders with a
Date_Client_Project tag. Makes it easier for everyone to figure out what someone
else was doing.

[However, I am very impressed with] how awesome it is to be able to grab a shot
off a hard drive without having to cue up a tape, shuttle to the appropriate
segment and capture. Log and transfer is great!

Steve Oakley - Digital Illusionist

[Tapeless is] not any faster than tape. To just dump a card, its maybe 4X to 6X
faster then RT which seems great, but once you figure in backup to at least one
more drive, that's cut in 1/2. tapeless is great for news, for super quick turn work
where you don't care about anything except getting something cut ASAP.

The next problem is having duplicate media file names like MVI_1234

Shooting double system sound is extra gear, and extra work. any time saved
shooting tapeless was just eaten up syncing sound, PluralEyes or not. DSLR's
don't have timecode, they don't even put the Time-of-Day as the timecode of a
clip, it always starts at 00:00:00:00. incredibly stupid. I'm hoping a third party will
come along with a utility to take the file creation time and use it to set ToD TC
into the file. Pat Pending.

[As a concern,] long-term backup will be a problem because tape is cheap and
reliable. I've got 15 year old beta SP's that play fine. how many 15 year old hard
drives do you have working or even have an interface you can connect them to to
try ? thankfully 2 TB drives are down to $129 now to back up all the 320-500G
drive's I've got right now. Until there is reliable long term digital storage format
where the media is very stable, and has an interface that's going to be
accessible.

Ben Daube

[When it comes to] labeling and Backup/Archive, you must be ruthlessly
disciplined in labeling and boringly consistent in copying/backing up/archiving.

[On the plus side, how] refreshingly easy and liberating the process is! And the
instant review/playback; no cards to lose with built-in memory; and no more
dropouts or tape caught in rollers, yeah!!



Jarle Leirpoll

I use the SxS cards in my EX-1 camera, and I will NEVER go back to tape.
Transferring the files to disc is lightning fast, as these cards (and the express
card slot) have an incredible speed. I also have a RAID 0 on my laptop, so the
file transfer is really quick.

Duplicate file names will not happen if you make sure to give your cameras
different prefixes. I have my own camera that spits out files with name starting
with JL (my initials), and any other camera I use will be set to something else.

I use Premiere Pro CS5 to edit this material, so no transcoding is necessary. Just
copy to drive, import to Premiere and edit.

Backup can easily be done while editing, so no extra time is used for that.

All in all, the file based workflow is MUCH faster and easier than tape.

The SxS cards are not cheap, but I think of them as a part of the camera, not as
a kind of "tape". They'll be used thousands of times before they wear out. I have
two 16 GB cards and two 8 GB cards, and I have never filled up all of them in
one day.

Also, for long time storage of my projects, I use external drives. Hard drives have
been cheaper than DV tape per gigabyte for many years now, and the difference
grows bigger every year. And opening a project from tape is not easy... Opening
it from the hard drive is quick and easy, so making new versions is very fast.

I don't really care how long my hard drives will last. I just bought a few 2 TB
RAIDs, and copied all my old projects onto two of them (yes, I want backup). My
data never stays long enough on one media (drive) for it to go bad. I expect this
to be the case for many years, until we get insane capacity solid state drives fort
permanent storage. Petabyte flash memory has been mentioned...

I highly recommend file-based workflow. And I really, really hate to work with
tape now.

Noah Kadner

The biggest mistakes people make who are new to tapeless are:

Not making backups of the entire original media card.
Not understanding the structure of the media card and how to repair
broken clips with the built-in repair services of the cameras; though not all
cameras have this.
Editing directly with the H.264 or Motion JPEG files generate by many
DSLR camera rather than transcoding to ProRes or another more suitable
editing format first.

In reflecting on their comments, there are many advantages to going tapeless:

Greater flexibility in video codecs and formats
Greater flexibility in frame rates
More innovative, and reliable, cameras
Faster access to images.

But there are also downsides:



File organization and naming are critical
Backup and archiving strategies need to be planned
Must consistently copy the entire contents of the card
Must use Log & Transfer when bringing footage into FCP, and, here, FCP 7 is better
than FCP 6.

I've learned that with Final Cut Pro 7, always use Log & Transfer to ingest your media.

Sony recently updated their XDCAM Transfer utility software so all ingesting (the process of
bringing media into Final Cut) can be done using Log & Transfer. [See the note from Andy
Mees below for more information on this.]

Also, for DSLR footage, Canon recently released a free new utility called -- EOS Movie Plug-
in -- that allows you to transcode your DSLR footage using Log & Transfer. This utility has
three big benefits:

It automatically adds time-of-day timecode to your video files
It automatically transcodes to the correct version of ProRes during ingest
It automatically loads the footage into the Browser once it's been ingested.

If you want to see step-by-step illustrations on how to work with the following tapeless media
formats, check out my Webinar on Tapeless & DSLR Media. In it we cover:

P2
XDCAM
AVCHD
DSLR
RED
H.264
Flip cameras

If you want to know how to convert from one video format to the next, check out my webinar
on Video Transcoding Compression Techniques.

UPDATE - Aug. 10, 2010

Peter Darg adds:

Thank you for review of handling tapeless media in the July newsletter.
One discovery about the new technology which I found to my regret was shooting
a scene on a Sony EX-1 and then ejecting the sxs card as soon as the red LED
turned green.

I wanted to check everything on my MacBook Pro. However, to my horror the file
was not complete and could not be read by Sony software or FCP.

Conclusion: don't be in a hurry to eject the card even if the LED has turned
green.
Give the card at least another minute in the camera slot after the green to
completely finish writing all the data (just as a good baker leaves the cake in the
oven an extra minute to let it brown a little).

Dan Novak adds:

I just wanted to send a quick note regarding one of your latest articles "Thoughts
on working with tapeless media".

I have an older Mac Book Pro and a Panosonic DVX100B which I connect via
mini DV/Firewire cable (I know kind of old school). 
I capture the footage in iMovie (its quick and easy) and use the laptop as a back
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up until the project is complete.

To get the footage from the laptop to my Desktop for editiing I connect the two
computer together using a Firewire 800 cable and transfer it via Target Disk
Mode.

This process really cuts down on the capturing time if I were to record to tape.

Thanks for all the great articles.

Richard Krentz also sent his comments:

Larry I see you're as solid as FCP, always good to read your news letter, I have
never came away without some good knowledge. On the tapeless media, i just
use it once and throw everything away, I am only interested in what comes out
the first time, it is so easy to just shoot some more, I think its the era we are in at
the present, shoot, use and throw, that's how I see it, I am using the new
Iphone4 and the new Sony Handycam, you need to talk about that, those two do
it all, edit Iphone4 in the Imovie app or edit the Sony in FCP, its the coming thing,
you are right its all about the story unless its 3D and wild effects, loved your
semiar in Vancouver -- will try for a webinar soon.

James Salkind adds:

I just finished reading the summer Newsletter, and I have a couple of
comments/suggestions, particularly regarding tapeless workflow. First, as almost
all the commentators mentioned, one big mistake users make is not properly
backing up the original media. A great tool for streamlining this workflow is
ShotPut Pro -- (www.imagineproducts.com/index.php?
main_page=product_info&cPath=1&products_id=2). It copies and verifies all
manner of tapeless media, and it does it to multiple drives at the same time. This
function is great for creating working and archival drives simultaneously.

Second, as was also mentioned, duplicate file names are an issue, especially
with DSLR cameras. For instance, on the Canon 5D, all movies have the "MVI_"
prefix, then a sequential number from 0001 to 9999. You can manually reset the
camera to 0001, but not to any other number, so on a multi-camera shoot, it's
fairly easy to get duplicate file names among the cameras. One work-around is
to organize the cards by camera -- name the folder that the card is copied to by
camera/date/card# -- and then add the camera number to the clip name.
"MVI_1234" would become "CAM1-MVI_1234". It's important to only have one
card open at a time in the Log & Transfer window, otherwise FCP will
automatically change the file numbering to prevent duplicate file names.

Lastly, regarding batch export of still images, I have found no automatic method
to remove the colons, other than hiring an intern/assistant.

Keep up the good work with the Newsletter. It's always informative and thought
provoking.

UPDATE - Aug. 12, 2010

Don Hertz adds:

There is a known issue with the Log and Transfer tool and the Canon EOS
plugin where it randomly truncates some clips it is importing. It is very important
for an editor to take a look at the final length of the clips in the bin and make
sure they match the original - re-encoding those that do not. This is especially
important if the editor was not involved with filming and may not realize a key
take or additional B-roll is missing.
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I've had many clips cut in half or even a quarter of their original length. The
problem seems to happen less if you don't touch your system while it is doing the
transfer but I've still had it happen. I haven't been able to get a response from
Canon yet on the issue but a Google search pulls up many others having the
same problem.

Larry replies: Thanks, I didn't know this.

Larry replies: Peter, Dan, Richard, James, and Don -- thanks for writing!

UPDATE - Aug. 20, 2010

Andy Mees sent me the following correction:

Was just pointed at the July/August edition of your newsletter, and whilst
browsing the this months selection of tips and tricks there was one thing that
stood out a little for me in the Tapeless Media section where you noted:

"Sony recently updated their XDCAM Transfer utility software so all
ingesting (the process of bringing media into Final Cut) can be done
using Log & Transfer."

I was wondering if that might need some clarification as "XDCAM Transfer" is
actually Sony's own stand-alone transfer application and is not really related to
the Log and Transfer interface in FCP (except in basic function).

What I think you meant is Sony's XDCAM EX Log and Transfer Plugin (recently
updated to version 1.2) which allows XDCAM EX users to ingest using FCP's Log
and Transfer (instead of having to use Sony's aforementioned XDCAM Transfer
app). And again, just for clarity, when speaking of XDCAM ingest you might want
to note that the XDCAM EX Log and Transfer plugin does not allow "all"
ingesting to be done by Log and Transfer, it works only for those ingesting media
recorded by Sony's XDCAM EX based systems ... for instance, it won't work for
those trying to ingest XDCAM HD (or SD) from XDCAM optical media.

Hope it helps, and keep up the good work with the newsletter.

Larry replies: Andy, thanks for sending this. I appreciate the clarification. I was referring to the
plug-in.

[ Go to Top. ]

A NOTE ON NAMING FOLDERS FOR TAPELESS MEDIA

One of the clear messages in successfully working with tapeless media is how you name your
files and folders.

Based on what I've read and my own experience, I've developed an easy-to-implement
workflow that will help prevent problems in your own projects.

Rule One

Always have two copies of your camera source media on two different storage
systems (either hard drives or RAIDs).

Rule Two

During production, copy the entire contents of a card into its own folder on the
hard disk.

http://pro.sony.com/bbsc/ssr/micro-xdcamexsite/resource.downloads.bbsccms-assets-micro-xdcamex-downloads-LogTransferUtilityAppleFCP.shtml


Rule Three

The name of the folder containing the contents of the card will be the name that
Final Cut Pro uses when ingesting the media from that card.

Rule Four

Once you've ingested the media into Final Cut, don't rename or move any
folders. As long as you don't move or rename a folder, reconnecting or re-
ingesting media from the source files is very, very easy from within Final Cut.

Having just finished a 20-episode XDCAM shoot for 2ReelGuys.com, here's the system I
developed.

When working with tapeless media, I work with a minimum of three hard drives:

Drive 1: Boot disk with operating system and applications
Drive 2: Final Cut Pro Documents folder, for all FCP-related media
Drive 3: Source media drive, for all original tapeless media.

On the third drive, I create a folder called Source Media.

Inside the Source Media folder, I create a folder for each Client, or group of projects, I'm
working on. This step isn't necessary, but I work on a variety of projects and clients and I like
keeping their media separate.

NOTE: The Client folder always starts with a two-letter client code. In this case, I
use JM for a fictitious client: "Just-a-Moment Productions."



Then, inside the Client folder I create a folder for each project.

NOTE: The Project folder starts with a two-letter, two-number code that I use to
label all project elements. Here's an article that explains this in more detail.

Then, during production, I create a folder for each card that's shot and copy the entire
contents of the card into its own folder. The name of this folder is critical, and I use this naming
convention:

Project code - Date shot (year-month-day) - Card #

The reason this folder name is so important is that when I get back into the editing suite and
ingest the media into Final Cut. Because this was shot tapeless, I use File > Log & Transfer
to bring in the clip.

http://www.larryjordan.biz/articles/lj_filenaming.html


Notice that as soon as I select a clip in the Browser window of Log & Transfer, the Logging
section of this window automatically loads the name of the source media folder into the Reel
field.

The great benefit to this is that the folder name is stored in the ingested clip on your hard disk,
in the FCP Browser, even in the clip located in the Timeline. This means that if you ever need
to recapture the clip, FCP already knows exactly where it is.

This makes recapturing accidentally erased media very fast and very simple. I know, because
I've tested it. Even if you change the name of the clip in the Browser, FCP still knows the
names of the source media file on your hard disk.

For a detailed, step-by-step illustration of how to work with lots of different tapeless media,
check out my recent webinar: Working with Tapeless and DSLR Media.

[ Go to Top. ]

TECHNICAL DEFINITION: STUFF

A technical term that means a "collection of somewhat related material that never contains
exactly what you are looking for."

[ Go to Top. ]

A GREAT NEW WAY TO LEARN SOMETHING -- WEBINARS

Our new Wednesday webinars -- web-based PowerUP seminars --
are increasingly well received and a great way to stay current on the
latest technology. Demand remains high, so we are extending them
into the fall; each week we present a new topic.

Web-based training is less expensive (for both of us) than in-person
training. Plus, between the live chat, video and audio, the whole
experience is highly interactive. Every session is specifically designed
to get your questions answered. Remember, you can always email us questions before the
event for us to answer.

We create a new webinar on most Wednesdays - presented three different times during the
day -- 9 AM, 1 PM, 6 PM (PDT). Here's our schedule for August and early September:

http://www.larryjordan.biz/sem/old seminars/webinar_2010b.html
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August 11: Creating Effects in Final Cut Pro
August 18: Creative New Plug-ins for Final Cut Pro
August 25: (No session)
Sept. 1: Creating Great-Looking Chroma-Keys Using Final Cut Pro
Sept. 8: (No session) 
Sept. 15: Editing 3D Video in Final Cut Pro

We keep each class small, so you can get your questions answered using our live, interactive
chat. We limit attendance to a maximum of 50 people per class.

Best of all, we keep the price small as well -- one hour of training for only $49.

PLUS, if you can't make the live event, we make each webinar available in our store about a
week after the event. We already have nine titles available, with more added each week.

Here are our Top 3 Titles:

1. Video Compression for the Web and DVD
2. Video Transcoding Compression Techniques
3. Working with Tapeless and DSLR Media

Click here to see the agenda for each event, and to sign up.

Click here to see a complete list of all available titles. Register today.

[ Go to Top. ]

MAKE SOLID OBJECTS DISAPPEAR WITH BCC MOTION KEY

August is turning into "Plug-In Month," which I'm finding very exciting.

Recently, I was asked to give a demo of the latest Boris Continuum Complete plug-in suite at
the LA Final Cut Pro User Group. At the end of August, I'm giving two presentations on plug-
ins at the WEVA (Wedding and Event Videographer's Association) Conference in Orlando,
Florida.

And, next week, my weekly webinar is devoted to taking a looking at some of the latest plug-
ins for Final Cut Pro. (One of the cool things about doing a new webinar every week is that it
forces me to really stay current on all the news and software, which I then get to share with
you.)

Next month, I've decided to write about many of these new plug-ins that I'm discovering. For
this month, however, I just want to show you one mind-blowing trick.

This is the Motion Key in Boris Continuum Complete (BCC).

HOW IT WORKS

Imagine you are shooting a scene -- and something spoils it. In this case, it's a car driving thru
my wide shot. Or, it could be a badly behaving guest at a wedding.

Wouldn't it be great if you could get rid of it?

You can, if two requirements are met:

1. The camera is on a tripod.
2. The object enters, leaves, or moves around the frame.

This is because:
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1. If everything in the scene is moving, the filter can't separate the bad from the good.
2. If the object is in the same location for the entire shot, you don't have any extra pixels

to work with.

What the filter does is replace the pixels of the image you want to remove with the pixels in
the same location when the object was not in the shot.

It's almost magical. Watch this… my hands will never leave my wrists!

GETTING STARTED

Here's the example we will use - a car driving through a wide shot. I want to keep the
movement of the people on the sidewalk, but lose the car. (Footage courtesy of Boris FX.)



1. Select the clip you want to process and apply the BCC Keys Matte > BCC Motion Key
filter.

2. Double-click the clip to load it into the Viewer and click the Filters tab to display that
window.

3. Drag the clip containing the image you want to remove from the BROWSER into the image
well in the Filters tab. This is almost always the same clip that you applied the filter to in the
Timeline.

What you are going to do is highlight the area containing the object you want to remove and
track it.



4. In the filters tab, set the Area Selection pop-up to the shape that best matches the object
to be removed -- rectangle or oval. In this case, a rectangle does a good job encompassing
the car.

5. Set a keyframe at the first frame where your object appears -- in this case it is at the
beginning of the shot -- for any parameters that change as the object moves.

In this shot, the size and shape of the rectangle don't change, so I only need to keyframe the
Area Position of the rectangle.

6. I adjusted the Area Scale and Area Aspect parameters to create a rectangle that
completely surrounds the car, including it's shadow, then added keyframes for Area Position
to track the rectangle as the car moves across the screen. I used three keyframes for the
beginning, middle and end of the shot.

7. Change the Mode from Setup Region to Remove Area.



This is Before.

This is After.

Wow!

I'll have more on this and other plug-ins in both my Plug-ins webinar and next month's
newsletter - but I couldn't wait to show you this effect.

[ Go to Top. ]

PRODUCT REVIEW: iStoragePro TOWER 8 RAID

This was a very challenging review to
write -- but not for the reasons you may
expect. It is an interesting story, though,
so read on.

But first, a bit of disclosure. (Click here to read my policy on product reviews and disclosure.)
iStoragePro contacted us a few months ago about sponsoring my podcast, the Digital
Production Buzz. We love sponsors, so we said YES!

After their ad started running, I became intrigued with their product, so I asked them to send
me a unit to review. I've done a lot of storage system reviews over the years, mostly
concentrating on the lower-cost side of the market. This month, I decided to see what riding a
real rocket felt like.
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The folks at iStoragePro graciously sent me TWO units - their new iStoragePro Tower 8-Bay
Series, and their 16-bay Rackmount SAS Expander JBOD System.

The Rackmount SAS JBOD System is a hulking brute of a monster that holds up to 32 TB of
data on 16 2TB hard drives. Weighing in at almost 80 pounds! I was stunned at the heft of this
thing. It's designed to meet the storage needs of the enterprise, designed to go in a rack in the
machine room, and support multiple editors working at once,

With dual power supplies, dual fans, dual banks of hard drives, this ravening beast can handle
any video format you care to throw at it.

However, it isn't designed for the edit bay. It's designed to be attached to an extremely fast
server, with edit stations connected via fiber optic cabling. I checked around my office and saw
that machine rooms, fiber optic cables, and multiple edit suites were pretty thin on the ground
around here. So, with a deep sigh of regret, I leashed this behemoth, put it back in the box,
and returned it to iStoragePro.

The rest of this review concentrates on the other unit iStoragePro shipped me: an iStoragePro
Tower 8-bay Mini-SAS JBOD System.

NOTE: "JBOD" means "Just-a-Bunch-of-Drives" and refers to an enclosure that
holds several hard drives; in this case eight drives. The RAID is created by the
RAID card, which is sold separately, and plugs into your tower computer. While
not impossible technically, RAID cards generally do not work with laptops or
iMacs. For instance, none of the five supported RAID cards works in the
ExpressCard/34 laptop slot of a 17" MacBook Pro. And smaller laptops don't
have the ExpressCard/34 slot at all.

A NOTE ON iStoragePro

iStoragePro is a brand of Ci Design, an Irvine-based storage company founded in 1983. Up
until recently, they have traditionally sold into the enterprise market through value-added
resellers. Their line of iStoragePro systems is their first foray into the audio/video market,
selling direct to end-users.

This move into a new sales channel is significant, as we will see in a bit.

PRODUCT DESCRIPTION

The Tower 8 stores up to 16 TB of data, using 8 hot-swappable
hard drives. ("Hot swappable" means you can take a dead drive
out and insert a new drive without turning off power to the
system, or losing access to the drive from your computer.) The
front of the unit locks to prevent the accidental removal of a
drive.

It connects to the computer via Mini-SAS, which is a truly high-
speed protocol that can deliver hundreds of megabytes per
second to your computer. However it requires installing an
interface card in your computer. Since this interface card also
doubles as your RAID card, this is not necessarily a bad thing.
However, the need for a card rules out any Mac that isn't a
MacPro.

iStoragePro lists five RAID cards that it has qualified for this unit, from Areca, ATTO, and
Highpoint. The unit arrived with an ATTO R380 PCI-e RAID card.

The Tower 8 supports RAID levels 0, 1, 2, 5, 6, 10 or JBOD. For video work with a unit like
this, only RAID levels 5 or 6 should be considered. RAID level 5 means you can lose one hard

http://www.istoragepro.com/products.php?id=t8
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drive while protecting your data. RAID level 6 means you can lose two drives simultaneously
without losing your data. I'm only a little paranoid so RAID level 5 is fine for me. Besides, the
performance and storage characteristics are better for RAID 5 vs. RAID 6.

It runs on Mac, Windows, and Linux systems, with a standard 3-year warranty. Designed to sit
on the desktop, it has four hard rubber feet on the bottom.

UNPACKING

The unit arrived in two boxes, one holding the eight hard drives (Western Digital 2.0 TB Black
drives - Enterprise class); and the other holding the unit itself.

NOTE: Western Digital Green drives are more energy efficient. Black drives
provide better performance. Since we are interested in video editing, I
recommend using Black drives.

The unit looks like a half-sized version of a MacPro. Same industrial design. Accessories were
nicely stored in plastic bags in a small box packed with the unit. Everything was there... except
a manual or a Quick Start guide.

Oh, well. How hard could it be?

INSTALLATION

The unit connects to the computer via Min-SAS; a truly high-speed connection that can deliver
hundreds of megabytes of data per second to the computer. The ATTO RAID card installed
easily, but since I didn't have a manual, I decided to guess and install it in the top slot of my
computer. Total installation took five minutes into my Mac Pro. (Yup, you're right -- wrong
guess.)

NOTE: A big benefit of using Mini-SAS connectors is that cables can be up to 10
meters (30 feet) long. This allows a lot of flexibility in where the unit gets placed.

Installing the hard drives was easy. Each slot on the Tower was labeled from 1 to 8, and each
drive had a number. Installation was simple:

Unlock the front of the Tower cabinet
Slide a drive out of its static-free bag
Push the blue button, which releases the handle.
Slide the drive into the cabinet
Push the handle until it clicked shut
Repeat until all drives are installed

Installing all eight drives took two minutes, tops. Then, lock the front of the cabinet. If you
worry about these things, take the keys with you. If you don't, leave the keys in the unit.

I really like the locks they use to make sure the drive stays put. And, there's a clamp on the
power cable to be sure the power doesn't disconnect by accident. EVERY hard disk should
have something like this!

NOTE TO OTHER MANUFACTURERS: How hard would it be to put some sort
of clamp on your power cable to keep it from accidentally slipping out? I get
angry every time I see a wall wart with a flimsy slide-in 9 volt power cable. All
our data is only secure as long as nothing disturbs that cable. Once it slides out -
- goodbye data. This is STUPID! Creating a means to secure the power cable to
the unit is neither expensive nor difficult.

Stop being lazy and find a way to keep your power cables from getting pulled
out.

OK, I'm done now.



After everything was installed, I weighed the unit: 33.5 pounds. Not light. But a third the weight
of the Rackmount RAID still growling quietly in its box.

At this point, things started to get confusing.

I have two MIni-SAS cables that shipped with the unit. Do I need both of them?

There are two ports on the ATTO card, but THREE on the Tower? Which cable goes where?

Unlike FireWire cables, which, like flimsy 9 volt power cables, can be easily pulled out of the
unit because there's nothing holding them in place except pressure, the Mini-SAS connectors
slide in and click/lock shut. If they don't click, you've installed them upside-down.

POWERING UP

With everything connected, I power the unit up. Nothing.

OK, maybe I installed something wrong. So I went to the support section of their website. They
provide 800 telephone support Monday thru Friday, but today was Saturday.

In rapid succession I discovered:

1. There are no FAQ's (Frequently Asked Questions) on their support page
2. There is no way to send an email to support from their support page
3. There are no manuals available on their support page
4. There are no installation instructions on their support page.
5. Worse, much of their website is written in English as a second language.

Hmmm... So, now I'm sitting here, writing up my notes and waiting till Monday so I can contact
support to figure out how to get the unit working.

Back in a bit....

THE REST OF THE STORY

First you should know that I hate writing bad reviews. I believe companies want to turn out
good products. If there are problems, part of my job is to point them out so they can fix them.

But there were a lot of problems here. So, rather than write about all my troubles, I decided to
set up a conference call with their product management team to discuss them. I would rather
talk about problems that were fixed, rather than problems unfixed.

If they were interested in making good products, they'd listen. If they weren't, they wouldn't.

Thanks to the help of Katie Khor, my main contact at iStoragePro and just a stellar person,
she put together a meeting with all their key product marketing, engineering, and business
development staff in about 24 hours. We spoke for 90 minutes.

During that time I learned that iStoragePro traditionally sells to VARs and other resellers that
configure the gear before it even gets into the customer's hands. This is their first move to
selling direct to end-users, so they had never considered the kinds of information we would
need to work with their gear.

After our conversation and over the next two weeks, they:

Totally redesigned their website making it a whole lot easier to find stuff
Hired an editor to make sure all their language is understandable English
Put all the tech manuals on-line and clearly accessible in the Support section, EXCEPT
for the Tower 8 unit, for some reason

STILL NEEDS WORK



Their website still needs a way to contact support via email, rather than phone. As well, the
Tower 8 documents need to be posted. And some key technical information is still missing -
see below.

But the changes I saw were a huge improvement!

SETTING UP THE SYSTEM

If you want to work with high-speed RAIDs, be sure to buy from an experienced vendor and
call the vendor's tech support lines to ask questions BEFORE you buy - just to be sure they
explain things in a way you can understand. I found iStoragePro's support team very helpful.

When you jump to the world of extremely high-speed RAIDs, you are no longer in the world of
Plug-and-Play. Configuration is neither simple nor obvious. And installation is absolutely not
fast.

Plan on investing time to get this to work - it took me several hours spread across three days.
However, the time invested was very well spent!

The Quick Start Guides are not helpful. Here's what the documentation is missing:

Before doing anything else, install the RAID card. This generally goes in either slot 1 or
2 (the top slot, or second one down). Picking the right slot is important, as not all slots
deliver the same speed. Check with tech support for advice regarding your computer.
Before connecting any cables to the computer, install the ATTO RAID drivers.
Then install the ATTO RAID configuration utility, which is necessary to set up the RAID
There are two power switches, an obvious one in the back and one hidden behind the
front locking door. This front switch is not mentioned in the manual. Turn this front
switch on first, then the one in back.
You need to connect two cables from the computer to the unit. Tech support will tell you
which ports, as they are not clearly illustrated in the manual.

Once the software is installed, connected, and powered up, you need to use the Configuration
Utility to create the RAID.

RAIDs, unlike hard disks, need to be created first, then formatted. Follow the ATTO user guide
to accomplish this task. Though lengthly, a RAID only needs to be created once.

The 12 TB drive I was testing took about 12 hours (yes, I wrote "hours") to build - and that
was in Express mode. Advanced mode is considered more reliable, at which point plan to
double your creation times. Your time will vary based upon the speed of your computer and
the size of the RAID, but allow PLENTY of time for this process.

NOTE: If you need to delete a RAID group, inside the Configuration Utility,
control+click the name of the group and select Delete. THEN, pull the interface
cable and plug it back in. Make sure all groups are gone and all disks mount.

When Creating the Group is complete, you won't see an icon on your desktop.



Instead, open Disk Utility and you'll see the name of your group on the left. Select the name
of the RAID from the window on the left.

Because you have already created the RAID, all you need to do is format it for a Mac. Click
the Erase tab at the top of the window.

Set the Format to Mac OS Extended and give the RAID a name. You don't need to journal a



RAID, only the Boot disk.

Then, click Erase in the lower right corner to begin the final formatting process. Unlike the
earlier process, this is very quick -- a matter of a few seconds.

When you are done, the icon of your RAID appears on your hard disk, ready to use.

SPEED TO BURN!

EGADS!!! This thing is FAST!!!!

And quieter than a MacPro. I mean this is virtually silent! Their silent fan technology is VERY
impressive.

Let's check out the numbers, using the AJA Speed Test utility.

Pushing 500 MB/second! And I discovered I didn't even have the RAID card in the fastest slot.
Smokin'.

By way of comparison, look at these numbers.

The fastest we can copy to a FireWire 800 RAID is about 80 MB/second.



The fastest we can copy to an eSATA 2-drive RAID is about 100 MB/second.

When I asked it to duplicate 1 TB of data files internal to the RAID, duplication speeds were
over 250 MB/second.

This drive is plenty fast enough to support multiple streams of uncompressed 1080p video for
multi-cam work.

Looking toward the future, editing 4K images requires a data transfer rate of 1.5 GB/second.
The 6 gbps backplane of this unit will allow up to 3 streams of simultaneous uncompressed 4K
editing. Wow…!

And in terms of ease-of-use, moving files around this RAID is exactly the same as if it were a
single internal hard drive on your computer.

CONCLUSION

Setup is not for the faint-of-heart. But if you want great gobs of speed in a dead quiet unit that
you can place a comfortable distance from your computer, this is a solid choice.

Take time to be sure you are putting cards and cables in the right locations. Picking the wrong
slot will significantly slow down the unit. Read all the manuals and allow time to contact tech
support and plan on waiting a day for the unit to be configure itself.

However, once you've got it installed and running, though, this is the fastest hard disk you've
ever worked with. The speed is breath-taking.

UPDATE - Aug. 11, 2010

Dave writes:

I just finished reading your review of the iStorage Pro 8 drive RAID and was
thoroughly entertained (at your expense!) and informed. However, I was
ultimately frustrated when I got to the end of the review and couldn't find any
pricing info. Was this (1) an oversight, (2) on purpose or, (3) my inability to find
it? I went to their site and became even more frustrated as I had to submit an
inquiry via email JUST to find out the darn price of the box. I know that you said
that they are a bit "new" at dealing direct with customers but this was extremely
frustrating. What was the suggested list price of the unit you were testing
(including the RAID card)?



                   

Larry replies: Dave, this is a good question. However, since the Tower 8-bay has six different
configurations, I asked iStoragePro to send me their pricing. They did, so as near as I can
determine:

Tower 8-Bay with 8 TB of storage: $1,815.00.
Tower 8-Bay with 16 TB of storage: $2,750.00
The ATTO R380 RAID card: $1,150.
(2) Mini-SAS Cables, $79 each: $158.
Total retail price, as tested, (8 TB): $3,123, (Pricing will vary by dealer.)

[ Go to Top. ]

ANNOUNCING THE LARRY JORDAN FORUMS

Here's another project we've been working on for the last several
months: a Forum for our website!

Yes, I know there are plenty of other forums out there. And some
of them are very good. Why create one here?

Well, the answer is that I get about 200 emails a day from people
asking questions. Questions that they can't get answered anywhere

else. And I try to respond to every one of them the same day.

The nice thing about this is that I get a really good idea of what common problems are. The
bad thing is that I end up repeating the same answers over and over and no one else benefits
from our conversation. (Also, I spend so much time answered emails, I don't have time to get
this newsletter written.)

It struck me a while ago that putting together a forum, where we can all share questions and
answers, would help all of us. This website is specifically focused on Final Cut Studio, so that's
the general focus of the forum as well.

It's all FREE and I'd love you to check it out. Visit: www.larryjordan.biz/forum.

[ Go to Top. ]

THOUGHTS ON A NEW WAY TO DO GREEN-SCREEN GRAPHICS

At the end of July, the Director's Guild of America held their annual "Digital Day," a chance for
directors to catch up on the latest industry happenings.

Since I'm a DGA member, I wanted to see some of the latest in high-end production
technology, so I went.

Scott Billups did a fabulous presentation on the new trend of compositing finished effects
during production -- what he calls "Zero Post." This allows directors and actors to see the
actual environment the actors are working in while on set, which aids trying to convey a sense
of space and emotion in a green-screen environment.

He went on to say: "Today, we can composite on set. Post-production and graphics houses
need to start thinking about creating final designs in PRE-production, not POST-production."

While this initially struck me as potentially taking business away from editors and post-
production facilities, I realized this is actually a great new opportunity for us.

Since all these images need to be created, it really doesn't matter if they are done before or
after production. One of the benefits of doing them before production is that the deadline
pressure is often less. Plus, once a director sees the final image, they can shape the actual
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shooting to better reflect the look of the scene.

Very few productions will accept the composite done during production as the "final version."
Instead, they'll leave that to the editor to weave into the final edit. Except this time, eye lines,
talent blocking, and acting are much more likely to match the image, which means we will
spend more time editing and less time fudging to get all these elements to work together.

Finally, this new trend allows all of us another way to sell our services. If you can draw, you
should be putting your name out there to create these images as part of the pre-production
process.

If you can't draw, you should put your name out there to handle all the on-set compositing
issues. Nobody does editing better than an editor. Don't leave this task to the nearest
production assistant. You can do the job faster and better.

Besides, you deserve the money.

[ Go to Top. ]

THOUGHTS ON 3D VIDEO

As part of that same DGA Digital Day, a long session was devoted to 3D video. While targeted
at directors, which means it wasn't very technical and concentrated on production, I was so
impressed with the challenges this new medium offers that I am creating a webinar in
September specifically to discuss this.

However, in the meantime, here are a series of thoughts I jotted down during the presentations
that can serve as a conversation starter for all of us.

Yesterday, the art of cinema was converting reality into 2D. Now, it's converting reality
into 3D.
All films are about story. But with 3D, we can also capture spatial experiences.
3D likes wider lenses and LESS depth of field; meaning more of the image is in focus.
Convergence determines where an image is in space. Small increments are easier to
watch that big.
The best place to put the convergence point is right behind the key actor or main point
of interest.
Setting 3D depth to match the screen plane is best. Move key actors just in front of the
screen plane.
3D requires both a focus-puller and a convergence-puller during a shot.
The process of converting 2D images to 3D is almost exactly the same as colorizing a
movie.
The process of converting 2D images to 3D is very, very labor intensive.
If you are converting a 2D image into 3D, be sure you add enough scale and depth to
make it worthwhile to watch.
Biggest challenge in converting 2D to 3D is making flat objects appear round. And
making hair look good.
An image which is very complex and busy in 2D, suddenly seems simple in 3D.
Imagine looking into tree branches, for example.
The key is to balance both lenses so that zoom, focus, and iris all track equally. Almost
no lenses are the same, or match that closely.
Provided your lenses balance, there is almost no difference between shooting 2D or 3D.
Move the camera half as fast as you would in HD. Dolly is better than pan.
When in doubt, keep your shot wider and make it simple so the eye and brain can
follow.

While I'm still of two minds about whether 3D is solely for theatrical release or whether it has
broader implications in the home, I thought you would be interested in what I learned.

http://www.larryjordan.biz/sem/old seminars/webinar_2010b.html#sep15


You can find out more about 3D video by attending my upcoming webinar on 3D in Final Cut
Pro.

[ Go to Top. ]

TECH NOTE: COMPUTER MONITOR FLASHES BLACK

I rearranged my office last week. Generally, this is a good thing, but this time it turned into an
adventure.

I needed to reposition my MacPro farther from the Apple 24" monitor I use. Since Apple thinks
that these monitors are only used with laptops, they only provide about 24" of monitor cable --
a good foot short of what I needed.

So, I went to my local Apple store, only to discover that they don't carry Mini-DisplayPort
extension cables.

"How am I supposed to use this monitor without holding a MacPro on my lap?" I asked.

"I don't know," they replied.

Time to visit my favorite computer reseller -- this one NOT owned by Apple -- and bought a
Belden six-foot Mini-DisplayPort extension cable.

Everything worked great… for a day. Then, periodically, the computer monitor flashed black.
Sometimes for a full second or two. Not good.

Fearing I'd damaged the graphics card in the move, I took the computer and monitor to a local
Apple store for a complete checkup. After running diagnostics for the better part of six hours,
the Apple Genius couldn't find anything wrong.

Brought everything home, plugged it all in. The flashes of black started almost immediately.

Since I can't connect the monitor to the computer without using the extension cable -- stupid
short monitor cable!! -- I can't say conclusively that the extension cable was the problem.

However, when I removed the 24" monitor and replaced it with a 23" monitor connected via
DVI, everything worked (and continues working) great.

Moral of the story: Be very careful adding extension cables to Mini-DisplayPort cables.

Second moral: Always check the length of cable that comes with a monitor before spending
hundreds of dollars on a monitor you can't connect.

Sigh…

[ Go to Top. ]

PASSING THOUGHTS

Short takes on interesting stuff.

WORKFLOW APPS FOR FCP AND COLOR

Joe Haughey sent me this:

I don't know if you know of us, we make workflow apps for FCP:
www.editmule.com

We've gone underground of late rebuilding our apps because they weren't exactly
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the most stable of brutes, but we've got them completely stable and lightning fast
now and would love to hear your opinion of them. We're concentrating on building
apps now that are most use to FCP / Color users...

So if theres anything you need that Apple doesn't provide that we might be able
to build, we're all ears :)

NEW ON KENSTONE.NET

Steve Douglas reviews CrumplePop's Revealer and Metal -- new plug-ins for Final Cut Pro.

www.kenstone.net/fcp_homepage/crumple_pop_revealer_metal_douglas.html

Jude Cotter reviews Loader V2.0. The function FCP Forgot.

www.kenstone.net/fcp_homepage/loader_cotter.html

Loren Miller reviews Keylight, chroma-key for the power-hungry.

www.kenstone.net/fcp_homepage/keylight_miller.html

FINAL CUT SERVER SPECULATION

Darrin Hills joins in the ever-popular sport of "Guessing What Apple Will Do™"

I am in the midst of a FCP Server install. And with that I have been reading the
PeachPit manual on FCP Server.

On the news of iMovie coming to iPhone and understanding that it is sometimes
easy to speculate...I have a prediction. Thus, FCP Server Client will be a Java
Application, with the iPhone, iPad as Java enabled Devices.

I see the future of FCP server having proxy editing on ipod and ipad...coming to
an App store near you!

LIVETYPE

Gayle Christensen writes:

In response to Alec Schreck in the Animating Text section of the latest
newsletter, for those like myself, who are trying like mad to pull themselves away
from our beloved phased out LiveType and trying to get your feet wet in Motion
for text, I have three words: templates, templates, templates!

I'm actually finding myself slowly becoming more comfortable working in Motion,
but only because I took the baby step of starting with a template (and watching a
few tutorials on Lynda.com) and removing the stuff I don't want and keeping the
stuff I do. And I must say, it wasn't so scary and I think I'm actually getting to the
point where I'm (almost) ready to create my own text from scratch.

COOL TRICK

Joe Hackett writes:

I was working with another editor who insisted on making a sequence in Final
Cut Pro of all the dailies. If he found something in his dailies sequence, his
intention was to MATCH FRAME IT.... and then go into his movie sequence...

But I discovered something truly brilliant, that he didn't know either.
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Create two sequences, "Seq - Act One" for your show master and "Seq - Dailies"
for show dailies.

Load "Seq - Dailies" into the Timeline. Double click one of the CLIPS in the
DAILIES sequence, thus putting it in the VIEWER WINDOW.

NOW open "Seq - Act One" into the Timeline.

Go back to the VIEWER, press the UP or DOWN ARROW -- each time, you'll
jump from one clip to the next in the Viewer!

HUGE IMAGES

David Ransley sent this in:

I was working with a large JPEG image (6000 � 4000 pixels) and when I went to
render my sequence I got the "Out of Memory" warning and was unable to
continue. At first I was stumped but I realized that I could successfully export the
sequence by selecting File, Export, Using Quicktime Conversion, and choosing
as Image Sequence, under Options I selected my frame rate, and don't for get to
make a new folder before rendering. When the render has finished import the
new folder and drag the folder to a new sequence.

Larry adds: Remember, FCP really doesn't like images greater than 4,000 pixels on a side. If
at all possible, keep your image sizes smaller than that.

DSLR SPEED EFFECTS

David Scott sent this in:

Regarding my recent inquiry regarding slo-mo: "True" slow motions with
consumer gear? Looks like the new Canon 7D DSLR shooting video at 60fps
(720p), then run through FCP's Cinema Tools can reconfigure the clip to play at,
say, half that speed and the result is pretty darn nice - vimeo.com/6912114

VERY COOL NEWSLETTER

If you haven't signed up for Phil South's newsletter for screen writers - Creative Genius
Newsletter - check it out.

Read his blog here:

goingdownwriting.wordpress.com/2010/07/28/making-people-care/

Ask questions about writing here at the Noun Collective:

noun.ideasdigital.com/

VERY COOL SOFTWARE

Looking for maintenance utilities specifically for Final Cut Pro?

Check out FCP Maintenance Pack from Digital Rebellion.

[ Go to Top. ]
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WORKING WITH MIXED MEDIA

Matt Cohn asks:

I am assisting on a project that is dealing with three different formats: XDCAM
EX, DVCPRO50, and archival material ripped from DVDs. Before getting into the
specifics, I want to let you know that the project needs to be delivered for
broadcast in ProRes at 29.97. Now for the workflow question.

We have decided that it would best to edit in a sequence setting of XDCAM EX
to match the XDCAM footage, so we need to figure out the best way to convert
the DVCPRO50 footage. I read in one of your past exchanges that you
recommended using ProRes 422. Would this make sense in our situation?
During that conversion we are likewise planning on converting the frame rate
from 29.97 to 23.98. Can this also be done with the ProRes 422 codec?

The goal is to be able to match the two formats that are not XDCAM EX to that
format using the best codecs possible and, finally, for output, we would then go
from the XDCAM EX codec to ProRes at 29.97, but only after color correcting
and audio mixing.

Larry replies: Matt, thanks for writing!

You have three issues:

1. Up-resing the SD footage to fit an HD timeline
2. Converting frame rates
3. Determining the best codec

First, depending upon your budget, you can up-res using Compressor or I've seen outstanding
work with tools from the Foundry - called Furnace Core - that can do the job, or you can take
your footage to a post house who can use a Teranex box to do a hardware up-conversion.

Second, I have NO idea why you want to do a frame rate conversion from 29.97 to 23.98 only
to go back to 29.97 for final delivery. This will make your footage look jerky and awful. If your
XDCAM material was shot at 23.98, convert it to 29.97 for smoother movement.   This double-
frame-rate-conversion step is unnecessary and decreases quality and wastes time.

Third, I like ProRes 422 for a common codec. For broadcast you can use either ProRes 422 or
ProRes 422 HQ.

Matt then asked:

I have a couple of follow up questions that I hope you have time to address. If we
were to edit the DVCPRO50 NTSC 29.97 footage on an XDCAM EX 1080p24
timeline - the majority of our footage is XDCAM at 23.98 - when it comes time to
output to say ProRes 422 at 29.97, how are the two different frame rates
addressed? In other words, am I correct in assuming that the XDCAM frame rate
and the DVCPRO frame rate have to match before output to the ProRes codec?

Second, if I understand correctly, and if we were to keep all footage in their
native codecs during editing, in an XDCAM EX 1080p24 sequence that plays
DVCPRO50 footage in real time, is it actually converting the 29.97 frame rate
during playback to 23.98. or is it playing back at 29.97 from the 23.98 timeline?

Finally, I wasn't sure if you meant to convert XDCAM footage, which was shot in
23.98, to 29.97 before editing, or once the edit was finished and we were ready
for output.

Larry replies: You can only have one frame rate per timeline. This means that you need to



either remove frames from the DVCPRO-50 material, which will look awful, or add pull-down
frames to the XDCAM EX material, which will look better than trying to remove frames.

This frame rate conversion can be done automatically by Final Cut Pro in the Timeline, or you
can do it before you even bring the material in for editing using Compressor (to add frames) or
Cinema Tools (to remove frames).

If you edit DVCPRO-509 material into an XDCAM timeline, Final Cut will automatically render it
into the correct image size, codec, and frame rate. This means you'll need to render every SD
clip you edit into your project. Whether the quality of this automatic process is acceptable to
you is up to you to decide.

I would suggest concerting all footage into a single ProRes codec - I recommend ProRes 422 -
at a single frame size, frame rate, and scanning (progressive) - so that you are editing only one
format on your timeline.

Then, when the project is done, export a high-quality self-contained QuickTime movie and
down-convert it to SD using Compressor for final distribution on DVD.

[ Go to Top. ]

FASTER SMOOTHCAM SMOOTHING

Adam Hyde writes:

I'm editing some shaky footage, and using SmoothCam in final cut quite a bit. It
comes out looking great, but it takes my computer a long time to analyze the
clips. I'm using my Mac Pro Dual Quad-Core 2.8 with 2GB of memory. Can you
suggest a way to speed thing up for me?

Larry replies: SmoothCam is processor-dependent, so faster computers will work faster than
slower ones.

Since you probably can't rush out and buy a new computer, here are two things to try.

OPTION 1 - Batch Processing

You can set up a batch of clips to process overnight, buy using the SmoothCam column in the
Browser.



Select the clips you want to stabilize in the Browser.

Control+click any Browser column header except the Name column. Select Show
SmoothCam from the list

Control+click in the SmoothCam column and select Run Analysis.



This sends all selected clips into a batch for SmoothCam to analyze. This allows you to have
the processing done overnight while you are away from your system.

OPTION 2 - Faster Analysis

Since SmoothCam analyzes the entire clip, it is often helpful to export just that portion of the
clip you want to smooth.

The best way to do this is to export it as a self-contained QuickTime movie, then reimport it
into your Timeline.

From there, you can apply the SmoothCam filter. The analysis will be quicker because the clip
is shorter.

UPDATE - Aug. 10, 2010

Robin Harris adds:

In your latest newsletter there's a note from Adam Hyde about speeding up
SmoothCam. There's a 3rd option:

Adam is is using a 8 core Mac Pro with 2 GB of memory - which isn't nearly
enough! 2 GB of RAM on an 8 core is like a Ferrari with bicycle wheels. I
suspect SmoothCam is doing a lot of swapping to disk to manage all the data -
which really slows things down.

Any FCP user should have 4 GB minimum, and I found my old quad-core Mac
Pro became faster and more stable with 8 GB. RAM is cheap - buy lots!

Larry replies: Robin, thanks for your comment. Keep in mind that, currently, FCP does not
access more than 4 GB of RAM, so adding more than 4 GB won't improve FCP; though adding
more RAM is a good policy for the future.

[ Go to Top. ]

AVCHD WORKFLOW

Steve Voisin asks:

I remember there was one newsletter where you explained tips & tricks of a good



'workflow' when logging AVCHD video from consumer HD cameras Sony/Canon
to a MacBook.

I have 3 multi cameras Canon Vixia HG21 and about 8 hours of content for a
conference for each camera (24 hours total), and there is no way I can allow my
machine to render/import all that footage onto that laptop.

My concern is transcoding time from AVCHD to Appel ProRes 4.2.2 and also
hard drive space (i have a 2TB hard drive, but frankly that may not be enough
considering the amount of footage we need on there!)

Please shoot over the link or any advice you have as to how to handle all that
AVCHD to ProRes on a semi-powerful MacBook Pro

Larry replies: Steve, my opinion on AVCHD has changed recently, as I was researching my
recent webinar on Tapeless Media.

I am now completely a fan of using the Log & Transfer function to ingest AVCHD. Because, it
handles the conversion to ProRes automatically, preserving timecode and loading it into the
FCP Browser.

Also, for AVCHD media, I recommend using ProRes 422, not HQ or 4444. The reason is the
AVCHD is so compressed in the camera, you won't see a different in quality by going to the
higher ProRes formats, while your file sizes will balloon.

Storage space is 11 GB per hour for the native AVCHD media, and 66 GB per hour for the
ProRes 422. Total space for 24 hours of material, assuming you capture all of it, would be 1.8
TB.

[ Go to Top. ]

FCP 7 BUGS

Steve Tyler writes:

I am a long time FCP user. Just upgraded to FCP7. Have to say I especially love
the organizational tools - colored and rippling markers.

I've noticed 2 bugs - one I've found documentation on the boards about - one I
haven't. Have sent notices to Apple but don't know how much they pay attention.

First is the strange close gap behavior when using Control-G. Oftentimes the gap
you're on doesn't close up, one further up (to the left) the timeline will close. It
seems to have something to do with checker-boarded audio and video. If all of
the video clips are on one track and the audio is the same number of tracks all
the way across the timeline, it will work. But if there's any staggering of audio,
the close gap function doesn't work correctly.

Also - and I haven't found anything on this one yet - the kb shortcut for
advancing one frame at a time doesn't seem to work anymore. Used to be that
you could hold down the K key and then press L and it would advance one
frame. Not anymore.

Any thoughts?

Larry replies: Steve, thanks for writing. Always good to hear from you.

I don't personally use the Close Gap function, so I can't answer that. As for a keyboard
shortcut to move one frame at a time, I have always used the left and right arrows.

Even faster, hold the Shift key down and press either the left or right arrow keys to move one

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=183


second at a time.

[ Go to Top. ]

ARCHIVING MEDIA WITH MEDIA MANAGER

William Aleman asks:

I just watched your FCP tutorial 21_Media Manager.mov. I'm getting ready to
upgrade to FCP 7. Does FCP 7 Media Manager include media files other than
the video clips (pictures, sound FX, etc)? In the past, the users had to copy
and/or move these types of files manually.

Larry replies: William, I thought Media Manager moved all the files in a project. So, I just did a
test using FCP 7.0.2.

I created a new project, added a video clip, a still image, and an AIF file to it and edited them
all down to the Timeline.

The key point to remember about using Media Manager is that you need to select what you
want to manage BEFORE selecting it from the menu. And, I always select what I want to
Media Manage in the Browser, not the Timeline.

So, I selected the sequence that I wanted to archive.



Opening Media Manager, I selected Copy from the pop-up menu and made sure that Delete
Unused Media is not checked. (This can cause LOTS of problems.)

I clicked the Browse button at the bottom, created a new folder and gave the new project a
name.

When Media Manager was done, it had moved all the clips into a new Media folder next to my



project file. (My project was called "Mixed Media," which is why FCP created the "Mixed
Media" folder inside the Media folder.)

So, as long as you select what you want to manage BEFORE starting Media Manager,
everything should move across OK.

Here's a video tutorial I created on how to gather all your media in one place for archiving
using Media Manager.
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WHAT DOES NATIVE MEAN?

Gayle Christensen asks:

I'm sorry, but I'm not understanding the concept of footage being "Native". I just
don't know what that means! Does that mean uncompressed or something?
Lately I've been shooting in HD 720PN, but that has more to do with the amount
of footage I can fit onto my P2 cards. Could you explain that to me, please?

Larry replies: Gayle, this is a good question and I'm sorry I haven't defined this earlier.

"Native" means that you are editing the video in the same format in which you shot it. The
opposite of "native" is "transcoded."

For instance, almost all SD formats are edited in the format they were shot -- DV, Beta SP,
DigiBeta. HD formats, on the other hand, are a mixed bunch.

Most HDV is edited natively, as is P2, XDCAM HD, XDCAM EX. However AVCHD needs to be
transcoded into ProRes before we can edit it.

This whole issue gets truly murky because FCP converts some formats, like P2, from it's native
MXF format into a QuickTime format that it can edit. Purists would argue that we are not,
therefore, editing P2 natively.

So, in general, "native" means editing the format you shot. "Transcoded," generally, means you
need to convert the video into a different format before you can edit it. And there's plenty of
room for everyone to disagree with everyone else on the precise definition.

[ Go to Top. ]

A VIDEO FORMAT "FOR THE REST OF US"

David Hackney asks:

At the agency I work for I'm generally editing footage from a Sony EX3, with its
XDCAM EX format.

When the Creative directors or Account teams want to see rough cuts I generally
drop a QT mov on their desktops in a half scale H.264 format.
This works OK for very short pieces like 30 and 60 seconds ads.

But lately I've started to work on longer edits 15 mins up to an hour.
So H.264 performance is becoming a struggle, particularly on the older macs
often with jerky playback and takes a long time to shuttle back and forth in
Quicktime player.

Can you suggest a more suitable export format for Boardroom / Creative review -
a reasonable trade off between quality / file size and playback performance on
mid spec. Apple laptops and mac mini's etc.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=100


Larry replies: David, thanks for writing!

If your material is interlaced, use Motion-JPEG A. If your material is progressive, use Photo-
JPEG. These don't create the smallest files but they both compress fast and should play back
fine.

Also, if you need a video format that plays best in PowerPoint on both Macs and PCs,
compress using MPEG-1.

[ Go to Top. ]

MONITORING VIDEO

Michael Matthews writes:

I have Final Cut Studio 2 on a MacPro tower. I am trying to capture footage from
DVCAM tapes shot with a Sony DSR 570 DVCAM in 4:3 NDF. the footage
looked great in the monitor, but when capturing in log and capture, the footage is
becoming aliased and a bit fuzzier than it should appear. I have sequence and
capture preset settings set to DV NTSC 48khz and device control preset set to
firewire NTSC NDF. After clips are captured again, it looks fuzzy and aliased in
the apple cinema HD display 23" flat panel. Please help if possible, I'm on
deadline and can't figure this out.

Larry replies: Michael, this may not be a capture problem but a viewing problem.

A DVCAM image is only 720 x 480 pixels. If you are viewing it full screen on a computer
monitor, it will seem blurry and aliased.

In Final Cut Pro, load an image into the Viewer and set the Viewing scale (the right-hand of
the three small menus at the top of the window) to 100%. If the image looks good at 100%,
then the problems you are seeing are due to excessive scaling (enlarging).

Michael replied:

That was the problem. I had the Viewer scaled to 112%--thanks so much for
your assistance.
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GRAYED OUT AUDIO FILTERS

Ben Balser pointed this out. He had a client that wanted to apply an audio filter to a clip -
except the name of the filter was grayed out in the Effects > Video Filters list.

The problem was Effects Availability. On my system, the effects disappear. On Ben's client's



system they go gray.

Effects > Effects Availability allows you to limit the number of effects listed by Final Cut. The
default setting is to show all effects recommended by Apple. But you can restrict what's
displayed in the Effects list by changing this setting to Only My Preferred Effects.

You control which effects are displayed from the Effects tab in the Browser. Checking a filter
in the Preferred column means that when Effects Availability is set to Only Preferred Effects,
only those effects that are checked will be displayed in the menus.
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BATCH PROCESSING

David Lee asks:

I have hundreds of .mov files that are rendered in lots of different codecs and i
need them all to be .mov files but they must be in the AIC codec, i don't need to
compress these files at all as I need them to look like the original file and be
rendered in Apple Intermediate Codec, how do I convert these files as a batch so
they are all AIC....

Larry replies: Thanks for writing, David! You can't do this in Final Cut, but you can do this
EASILY in Compressor.

First, if you have the choice, ProRes will be a better option than AIC. However, if you are
running an older version of FCP, or using an older computer system, AIC is the better choice.

In Compressor, create the file settings you want to automate. In other words, create a specific
compression setting for the AIC codec.

Be sure to also create a custom destination where you want your converted files to be stored.

Then, select that setting and follow the instructions in this article:

www.larryjordan.biz/articles/lj_droplet.html

Finally, take your original source files - in groups of about 30-40 -- and drop them on a
droplet. This automates the process of converting them from one format to another. (Past
versions of compressor had problems when more than about 50 files were dropped on a
droplet at one time. Divide large groups of files into smaller groups and you'll be OK.)
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COPING WITH KERNAL PANICS

Gen Ritter writes:

I can't remember ever reading about kernel panic in any of your letters, which is
ok, but you might want to think about writing about it.

Is this a possibility: My Sony Vegas Platinum Edition 9 won't print to tape to a
Sony camcorder. So I exported it to QT format *.mov and brought it over to my
G-5.

It said that the mov file was 39.7 MB/second (FCP number in Browser). Opened
QT Player, opened the *.mov file, exported to DV Stream, thinking that this would
get it to the correct 3.6 MB/second. It did not. It was 6.9 MB/second in a mov
file. So all at one time I had QT Player open with the 39.7 MB/second file, QT
Player open with the 6.9MB/second file, FCP open with the 6.9MB/second file in
the TL (played great in the viewer, produced a red line in the TL) and Viewer.
Before I could even render, I got a kernel panic.

I took the computer to the Apple Store where I bought it Just heard back. They
said my memory 2GB was bad, they wanted to know if it was third party ram. So
I attached the receipt (sent to you, also) that showed it was Apple Ram and
exactly what kind.

I think what happened was I asked the OS to use too much RAM at one time and
it tried to do it and then I burned it up. Can this be true?

http://www.larryjordan.biz/articles/lj_droplet.html


Larry replies: Thanks for writing, Gen! It is always good to hear from you.

Can it be true that you "burned up your RAM loading too many movies into QuickTime?" No.

Can it be true that your RAM is bad? Yes.

A kernel panic is a complete crash of the operating system - probably the most serious
software crash that exists.

As the Apple Store intimated, kernel panics are generally not caused by a single application,
but by the interaction between the software and hardware. I can completely believe that bad
RAM could cause this.

Having multiple files open in QuickTime - even the different formats you mention -- should not
strain your system so as to cause a crash. Rather, I suspect that some portion of the RAM
failed.

However, I'm troubled by the video file created by Vegas that's 39.7 MB/second. There is no
SD video format with that data rate. Nothing even close. DigiBeta, which is the largest SD
video file format, only runs at 26.5 MB/second.

I think Vegas is creating files that may be part of the problem as well.

UPDATE - Aug. 10, 2010

Robin Harris adds:

In the question about kernel panics: if you suspect there may be RAM problems
you can go into About This Mac > More Info > Memory and OS X will tell you
the status of each DIMM. Now, if the status says there is an error, don't panic!
There are many transitory errors in RAM and it is highly likely that a reboot will
restore the DIMM to the OK status.

But if a reboot doesn't restore the DIMM to OK status, you probably have a failed
DIMM. Many 3rd party DIMMs have lifetime warranties, so check with your
vendor.

Apple's internal DIMM tests may not find every problem. If you still suspect RAM
problems you can download Memtest for about $2, boot into single-user mode,
and run it for a more complete test.

The good news is that on a Mac Pro you have Error Correcting Code (ECC)
memory, that detects and corrects single bit errors. But iMacs and MacBooks
don't have that, so you can have memory errors and the system won't know,
leading to possible file corruption or application failure.

As it happens, memory errors are a lot more common than expected. See my
ZDnet article, "DRAM error rates: Nightmare on DIMM street" at
www.zdnet.com/blog/storage/dram-error-rates-nightmare-on-dimm-street/638 for
the results of a Google/Carnegie Mellon large-scale study of DRAM error rates.

Larry replies: Robin, thanks.

[ Go to Top. ]

TRANSCODING FORMATS

Mike Henry writes:

As a long-time reader, thanks as always for all of your words of wisdom in our

http://www.zdnet.com/blog/storage/dram-error-rates-nightmare-on-dimm-street/638


industry.

I am writing to see if you have any best practices with mixing cameras with
different resolutions. I shoot on a Sony NXCAM with the highest quality AVCHD
at 1920x1080 and a Sony V1U with HDV at 1440x1080 as my B camera. Both
are shot at the same frame rate (30).

I bring the NXCAM footage in to FCP via ProRes and edit on a 1920 timeline.
However, when I bring in my second camera's footage, I have to blow it up to
133% to fit the timeline. The quality is unacceptable. I have also tried editing the
1920 footage on a 1440 HDV timeline which seems to work better, but I am then
scaling-down my higher quality footage to work with the 1440 footage. This
seems to defeat the purpose of the higher quality footage.

Do you have any thoughts on the best workflow to use both cameras on the
same timeline in FCP? My final output is a full-size master for archival and then
down-conversion to DVD for client delivery. Thanks for the advice!

Larry replies: Even under ideal circumstances, the quality of most HDV cameras does not
equal the quality of NXCAM cameras.

The compression is different (and HDV is very lossy), the pixel aspect ratio is different, the
quality of lenses is different, and the image quality is different; they just don't match.

HDV will also take longer to render.

Still, you don't need to zoom the HDV footage to get is to size correctly. Instead, you need to
adjust the pixel aspect ratio of each clip to match the NXCAM footage. NXCAM uses square
pixels, HDV uses rectangular pixels.

Here's an approach that may be easier.

The key is to get the two formats to match. BOTH NXCAM and HDV are shooting 1920 x
1080, however HDV does it by changing the shape of the pixel.

Rather than mess with it in the Motion tab, a much better approach would be to use
Compressor to transcode the HDV footage into the same format at NXCAM.

When you capture the NXCAM, if you are using Log & Transfer, FCP is converting it to ProRes
at the time of transfer. Open one of the ProRes clips in QuickTime, press Command-I and
write down the settings for the clip.

Then, in Compressor, transcode the HDV clips BEFORE you start editing into the same
ProRes format.

Then, when you bring both the HDV and NXCAM clips into the FCP timeline, the formats will
match, no rendering is required and the images should look comparable, though the HDV will
be a bit softer than the NXCAM.
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BLU-RAY HD BLUES

Pamela Beaty writes:

Please excuse me if I get long-winded.

We recently did a trip to the Delta, Botswana and I got some really nice photos
and video footage of game, taken with my Canon 5D Mark II.

Instead of using FCP, I used iMovie to edit everything due to the easy



acceptance of photos, the map showing the route, etc.

The footage and photos looked great and came to 35 minutes, after much
editing. I then transferred to footage to iDVD (not at all great).

I then decided to produce a QT movie and my settings were as follows:

Compression: Apple ProRes 422 HQ
Dimensions: 1920 x 1080

The results : Fantastic.....True HD

Followed your DVD Studio Pro lessons on Lynda.com, did some fantastic
menus...transferred everything to Toast and got … problems.

Please could you give me some advise with which codec to use to get the great
HD quality on a 4.7GB DVD. Have I missed something? (maybe doing something
wrong)

Larry replies: Pam, you are asking the $64,000 question.

Basically, you can't get there from here.

Currently, the only HD format supported on optical media is Blu-ray Discs. And the Mac does
not support playback of Blu-ray Discs. (Though you can purchase drivers that support it, the
built-in DVD player won't play it.)

Worse, DVD SP does not create Blu-ray Disks. At all. Period.

You have three options:

Option 1. Using Compressor or Final Cut Pro, you can burn a single movie in a format called
"AVCHD" -- which is media encoded into Blu-ray format, but burned onto a standard 4.3 GB
DVD. The good news is that you can do it. The bad news is:

You can't play the disc on your Mac
You must buy an external Blu-ray playback device, like a PS3
You can only burn one movie per disc
The movie needs to be 30 minutes or shorter
The movie is not as high a quality as a standard Blu-ray Disc
You can't create custom menus, only work with templates

Option 2. Export your project as an HD QuickTime movie, then burn it to Blu-ray Disc using
Roxio Toast. Movie quality is great, however menus are only templates. You don't have the
authoring ability you have tin DVD SP. Not even close.

Option 3. You can use Adobe Production Premium. Adobe Encore, which is part of the suite,
allows you to create both standard-def DVDs AND Blu-ray Discs, with full menus and
everything. Works great.

For now, creating Blu-ray Discs on a Mac are a very awkward situation.

[ Go to Top. ]

MOVING MARKERS

Andy Lindsay asks:

Let's say you might have accidentally put about 40 chapter markers into a
sequence and only later realized you had put them all into clips rather than into
the timeline. Is there some functionality to convert them from the clips into the

http://www.roxio.com/
http://www.adobe.com/products/creativesuite/production/


timeline? Apparently DVD Studio Pro doesn't recognize them when they are
embedded in clips.

Larry replies: Sigh... Nope. Sorry, Andy, can't be done in either FCP 6 or 7.

UPDATE - Aug. 10, 2010

Andreas Kiel adds:

Regarding FCP you're totally right -- but, as always, you may use XML to get out
of the dilemma.

There is a little tool of mine which allows to 'juggle' markers within sequences. It
currently doesn't work with 10.6, but it's free and can be downloaded from:

www.spherico.com/filmtools/markerTool/index.html

Larry replies: Andreas, thanks! It is always good to hear from you.

UPDATE - Aug. 12, 2010

Andreas Kiel adds:

After some of your readers asked for a Snow Leopard version I created one.
It can be found on the same site.

Don Hertz asks:

The question about Markers made me think about my own, many, questions
about Markers and how slow they seem to be to work with after creation. Is there
a way to slide a marker around once created? Secondly, is there a way to
change the default color on markers? Last and most important - is there a way to
select multiple markers and delete them?

Larry replies: Don, thanks for writing.

If you own FCP 6 or earlier, the answer to all three of your questions is, essentially, no.

In FCP 7:

You move a marker by pressing the Command key while dragging the marker
There are several ways to change marker color - you have eight to choose from. The
easiest is to move to a marker, type M to open the Edit Marker dialog box, and select
the color you want.
You can delete one marker, or all markers, but not a range of markers.
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MISSING MUSIC

Jon Freedman asks:

Just rushed together a video for a friend who needed it out the door fast. I was
given music on an external drive. Everything went fine until near the end I noticed
that the music that was seen in the time line (with waveform and all) just wasn't
heard.

No time to look into it but as things progressed I seem to recall playing it down
and hearing it then as I was editing not hearing it. At one point the tracks
appeared white (blank) I think because I must have unplugged the drive the
media was on so the client could use it to give me some photos.

http://www.spherico.com/filmtools/markerTool/index.html


Then I had problems getting some of my other external drives to even appear on
the desktop. Finally after restarting and running disc utility and trashing the
preferences I seemed to get everything together but even though I saw the music
and waveforms and could hear the SFX track that came from the same source
when I output the movie file and played it back there was no music.

Larry replies: Jon, there's gotta be some sort of mantra we can recite when the client says:
"Just do this quick, don't bother to do it right…"

Unplugging a drive containing the music would, indeed, cause the white clips you describe -
indicating that the media is off-line.

Also, if you nest sequences, that can also cause audio to disappear.

Assuming all your audio is relinked and available, the best way to make sure all your clips
render is to select Sequence > Render Only > Mix-down.

I suspect that will fix your problem.

[ Go to Top. ]

TIMELINE COLOR CHANGE

Trent asks:

In FCP, in the timeline, in 3 of the different sequences I am working on, the color
of the Audio track is a light green color, and I think this is the normal color.
However, when I open the master final sequence that I am working on (under a
severe deadline of course), the Audio track is a MUCH lighter, brighter green
color???

Does this matter, how did it suddenly turn a brighter color? Any way to get it
back to normal?

Larry replies: Yup, easily!

The color changes are caused by accidentally setting an In or an Out in the Timeline.

To remove the In, press Option+I.

To remove the Out, press Option+O.

To remove the In and the Out, press Option+X.

[ Go to Top. ]

TWO QUESTIONS LARRY NEEDS HELP WITH



DOES IMOVIE RE-ENCODE VIDEO

John Mozzer asks:

After capturing many analog Hi8 and miniDV tapes into iMovie HD 6.0.4, I used
its Full Quality export to create DV Stream files (with the ".dv" extension) -- which
as far as I know, is no longer available in iMovie.

I started using a program called DV Analyzer (
http://www.avpreserve.com/dvanalyzer/ ) to look at metadata in files with DV,
which reports DV timecode and the camcorder timestamps for every single frame
(as long as the file is not too big.) This metadata is still present in files created
with iMovie HD 6.0.4's Full Quality export.

In comparison, DV Analyzer shows the DV timecode as all zeroes, and the
camcorder timestamps as all X's, in DV files created via Quicktime Conversion in
Final Cut Express.

I believe this is evidence that iMovie's HD 6.0.4's Full Quality export feature does
not re-encode. Will you please tell me whether you think I am correct?

Larry replies: John, you can lose metadata without necessarily re-encoding the video portion of
a clip. However, I don't know the answer to this question. If any reader's know, I'll update this
issue.
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BATCH EXPORTING STILLS

Ben Balser sent me this puzzler:

I do a LOT of production stills with many of my video editing projects. I make a
Bin called Stills, and as I go through Sequences and Clips, I make Freeze
Frames, and drop them into the Stills Bin. I can open one into the Viewer, then
use File > Export > Quicktime Conversion, and the name the still gets, once
exported into the Finder, is OS X legal. For example, "MVI_0630 - 2010-05-30 at
10_09_35 101000;25". The colons in the timecode part of the name are stripped
out automatically. But that is very time consuming when I have 50 or so stills to
export at one time.

If I use Batch Export, it's very easy, EXCEPT that Batch Export does NOT alter the name from
what is in the Browser, and I get an "Illegal Name" error message. For example "MVI_0630 -
2010-05-30 at 10_09_35 10:10:00;25", which is what FCP gave this still when it was created. I
have tested, and if I strip out the colons, leave the semicolon, it works.

Gosh darn I wish Batch Export did the same thing Quicktime Conversion Export did. Do you
know any way to change the names of these stills (Freeze Frames) in any automated way?

Larry replies: Nope. But if a reader knows the answer, I'll pass it along.

UPDATE - Aug. 10, 2010

Zak Ray asks:

In regards to Ben's issue, is he using the "Quicktime (Custom)" setting for the
Format tab? This setting essentially provides the Quicktime Conversion interface
and may fix the illegal names.

Larry replies: I don't know, Zak, I'll send this to Ben and find out.

[ Go to Top. ]



WRAP-UP

Well, that's about it for this issue. I'm still wading thru all the email. Feel free to use my Forum
for questions. That way, we can all learn from each other.

For current news and in-depth interviews on what's happening in our industry, be sure to listen
to the Digital Production BuZZ every week.

Also, please consider supporting this newsletter by:

Registering for one of my webinars.
Buying a tutorial - decrease your stress and get back to work.
Or, buy a mouse pad -- you know you need a new one...

Also, please continue sending me your comments and questions. I love hearing from you and
enjoy the conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter!

Email:  

[ Click here for a printer-friendly PDF version of this issue. 2.5 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign
up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication.
However, due to the variety of possible system and software configurations, the author
assumes no liability in case things go wrong. Please use your best judgment in applying
these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has
not been reviewed or sanctioned by Apple or any other third party. All trademarks are the
property of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2010 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter
may not be reproduced or published in any way, in whole or in part, without specific
written permission from the author.

Links to my home page, blog, or web site articles are welcome and don't require prior
permission.
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